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Procedure Statement

This procedure describes the process for notification to supervisors and employees who have not
completed Institutional Compliance trainings by the designated due date.

Scope
This procedure applies to the Office of Institutional Compliance or a designated department
employee.

Procedure
Creating Tech Training Reports
1. Log in to the Tech Training application with Texas Tech credentials. The Tech Training

application can be found on the TTUHSC El Paso Office of Institutional Compliance
webpage or by using the following link https://academic.elpaso.ttuhsc.edu/TechTraining/.

2. Download the User Trainings Report. This can be found at Reports dropdown > Compliance
> User Trainings Report.

a. There are four User Trainings Reports for Compliance that will be combined into one
report.

b. In the Search Criteria section: Leave the eRaider field blank. Select the desired date
range. Select one of the following trainings: Ethics and Standard of Conduct, HIPAA,
Conflict of Interest, and General Compliance. In the Training Status section, keep the
All radio button checked.

c. Click the Search button.

d. Open the selected report via Microsoft Excel.

e. Repeat steps b. through d. to pull the remaining reports. For each remaining report,
copy and paste the report onto the first report you created in Excel.

i. Delete the first row of each remaining report you add to the first report.
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3. Save the report as YYYY-MM-DD User Training Report in the following BillCom
Server folder:

BillComFiles$ (\\elpdeptfs02) (S:) » Training * _Mandatory Compliance Training List > 2024 Delinquent Notices

a. Reports from Tech Training are a CSV file; save the file as an Excel Workbook.

b. Bold and add filters to the first row in the combined report.

c. Please note that a folder for each year will need to be created using the following
format: YYYY Delinquent Notices.

d. REMEMBER TO SAVE THE SPREADSHEET AFTER EACH STEP.

4. Once you have combined the reports, filter the combined report as follows:
a. Highlight Row I and bold the text of the headers.

b. Filter the Termination Date column, i.e. remove all entries that have a termination date
leaving only the blanks in the column.

c. Filter the Training Due Date column, i.e. deselect future dates. This will remove
individuals who are not delinquent.

d. Filter in the Training Completed column, i.e. deselect Yes. This will remove
individuals who have completed the trainings.

e. Copy and paste the remaining data to a new workbook page. Label this worksheet page
as Delinquent Learner Data.

Create the Pivot Table

1. Click on any cell containing data in the Delinquent Learner Data worksheet.

20 13506/ 2023 Conflict ot Interest
21 35064 2023 Conflict of Interest

Tech Tllh'ainin.g - User Training R Sheet1 | Delinquent Learner Data 6-)

Select destination and press ENTER or choose Paste

2. Open the Insert tab, and select Create Pivot Table.
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- HOME INSERT PAGE LAYO

PivotTable Recommended Table Plctures C
PivotTables Pi

Tables llusti
3. Create a pivot table with the department field and the delinquent learner names.

a. First add the department to the pivot table.
1. Highlight the department names so they will be easily discernable.
b. Add the learner field under the department field.

4. Name the worksheet as Delinquent Learner List. This list is going to be sent to
supervisors and delinquent learners.

a. Add a department slicer.

A B C D E F
1
2
3 |Row Labels - Department =
4 | = AHEC Elp
e AHEC Elp 0
6 Anesthesiology Elp ...
; Applications Develo...

w0

Bldg Maint and Op Elp

10 | = Anesthesiology Elp Genl
i)

12 Clinical Operations ...
=

14
15 Clinical Operations IM

Clinic and Basic Scie...

Clinical Operations ...

16 .
31 | =/ Bldg Maint and Op Elp |

1 Delinquent Learner Data | Delinquent Learner List I Department Data Mo. of people by Departm

Creating the Notification to Employees and their Supervisors

1. Use the Office of Institutional Compliance Directory to search for the name and email of
the department supervisors/chair. The directory can be found at Batman folder >
_Directory (copy) > TTUHSC Directory  (Your name) or use the most recent directory.

2. Create an email to notify the supervisors and delinquent employees.

a. The Delinquent Learners List is attached to the email,
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b. The email is sent to the delinquent employee,
c. Copy the employee’s supervisor,
d. Copy Dr. Richard Lange, Megan Graham, and ICO on the email.

3. Creating the delinquent employee email list:

a. Open the worksheet titled, Delinquent Learner Data,
b. Click on the letter above the column titled, Email to highlight the entire column.

Full Name Email -|Start Date

c. With the column highlighted, open the filter for this column and deselect (Blanks).

4. Create a new worksheet and title the worksheet, Email Delinquent Learners.

e

4 ... | Active Employees | Sheet4 | Delinquent Learner Data | Email Delinquent Learners

5. Copy the list of emails from step 3 of this section into the Email Delinquent Learners
worksheet.

a. Steps 3 through 5 of this section are necessary to remove the blanks from the email
column because not all employees have an email listed in Banner.

This is an example of the departments failing to accurately maintain employee data in
the Banner system.

6. Once you have copied the emails for the delinquent learners into the Email Delinquent
Learners worksheet:

a. Select the entire email column.
b. Go to the Data tab and click on Remove Duplicates.
c. Click OK.

1. This will delete the duplicate emails and will leave only one email per individual.
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File  Home Inset Pagelayout Formulas (WIS Review View  Help  Acrobat Q) Tell mewhat you want to do
= 7] Queries & Connections ~ a H =
e B B B [k 2 L -
Get  From From FromTable/ Recent = Existing  Refresh z| Sert  Filter Textto Flash | Remove | [
Data - Text/CSV Web  Range Sources Connections  All~ . Yo Advanced | Columns  Fill |Duplicates palic
Get & Transform Data Queries & Connections Sort & Filter
A2 - Fe
A B C D E F G H J K
1 [Email
5 Remove Duplicates ? ®
3 Ta delete duplicate values, select one or more columns that contain duplicates,
4
5 5= Unselect All [ My data has headers
3
7 Columns
8 [ Email
9
10
1
12
13
15

7. From June to the end of the calendar year, monthly notifications will be sent to delinquent
employees and supervisors.

a. At least two monthly notifications will be sent during November and December.

Department Count Reports

1. Using the Combined Tech Training Report in step 2 from the Creating Tech Training
Reports section, create two pivot tables. The first table will demonstrate the number of
individuals per department and the second table will demonstrate the department's total
completions and completion percentage.

a. Clear the filters on the Training Completed column, i.e. keep selected the Yes and No
options. This will give you a count of all the individuals in the department.

b. Copy the data to a new worksheet. Name this worksheet as Department Data.

c. Select the entire data and go to the Data tab. Click on Remove Duplicates. Unselect
All and leave the Rnumber option checked. Click OK.

1 T e B BH | =X B-
| et Fiter Textto Flash| Remove | Data  Consolidate
W Advanced | Columns  Fill | Duplicates Jalidation =

Sort & Filter n Data Tools

D E

= [ Traininacamnlatad [« | Tezining

Rem plicates Q ?
To delete duplicate values, ane or more columns that contain duplicates.
5= select Al | | 8 Unselect Al @ My data has headers

|
[T TerminationDate
2024 CONTIICT OT INTEFest Yes
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d. Using the Department Data, create the 2 pivot tables. The first pivot table needs to be
named No. of people by Department and the second pivot table will be named
Department Total.

e. Add a department slicer to both pivot tables.

A B = D E F G H J
1
2
3 |Row Labels ~ | Count of FullName Department =
4 |Accounting Services Elp 9 =
5 [AHECEIp g Physical Plant Elp
6 iology Elp Genl 27 PLFSOM Academic ...
7 |Applications Development Elp PLESOM Admissions
& |Assc Dean Clinical Affairs Elp 7
9 |Biostat And Epi Consulting Lab BECL 2 Police Elp
10 |Bldg Maint and Op Elp 36 President TTUHSC a...
11 |Budget Office Elp a = = |
12 |Business Affairs Elp 1 Psychiatry Child Fel...
13 |Clinic and Basic Sciences Elp 43 Psychiatry DeptElp ...
14 lenfcal OpErathns BCC 6 e
15 |Clinical Operations Elp 4
16 |Clinical Operations FM 29
17 |Clinical Operations IM 46
38 |Emergency Medicine Elp Genl 140
4 Delinquent Learner Data Delinquent Learner List Department Data T No. of people by Department I Department Total
A B C D E F G H M
1
2
3 Row Labels 1| Count of Department Count of TrainingCompleted
4 | =IPsychiatry Dept Elp Genl 124 100.00% Department = %
5 No 63 50.81% —
6 Yes 61 49.19% PLFSOM Academic ...
7 |Grand Total 124 PLFSOM Admissions
8
Police El
9 p
10 President TTUHSC a...
" Psychiatry Child Fell...
12
13 Psychiatry Dept Elp ... = W
14 Purchasing Elp
:2 Quality Improveme...
22
23
24

« ... | Delinquent Learner Data Delinquent Learner List Department Data No. of people by Department | Department Total ® < )

Delinquent Reports for the Past 2 Years

1. This report will reflect and compare 2 years of completion of trainings.

2. Create two reports, one for the current year and one for the year before. Follow steps 1 — 4
in the Creating Tech Trainings Reports section to create the reports.

a. Name the current year report worksheet as “Year” Delinquent. For example, 2024
Delinquent.

b. Name the report for the year before worksheet as “Year” Delinquent. For example,
2023 Delinquent.
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3. Highlight Row 1 and bold the text of the headers.

4. Add filters to the columns.
5. Expand the column widths so all data is readily visible.

6. Insert a column to the left of the column titled Eraider.

\ A B C D

1 Eraider |~ FullName - | Email -
2

a. Cut the Rnumber column and paste it in column A which is the blank column to the
left of the Eraider column. Name the column with the current year.

\ A : c b

1 2024 |~ Eraider |~ FullMame - | Email -
2

7. Insert a column to the left of the column with the current year.

“ A B c D E

1 2024 |~ |Eraider |~ |FullName ~ |[Email hd
2

8. Utilizing the report for the previous year, copy the column with the Rnumbers.

a. Paste the Rnumbers in column A which is the blank column to the left of the current
year column you created. Name the column with the previous year.

“ N . c 5 .

1 2023 |~ 2024 |~ |Eraider |~ FullName ~ | Email h
2

9. Insert a column to the right of the column with the current year and name it VLOOKUP.

A\C D E F

1 2023 |~ 2024 |~| VLOOKUP - |Eraider |~ FullName ~ | Email -
2

10. Perform the VLOOKUP of the delinquent learners in column B against the Rnumbers from
the previous year (column A).
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11. In the column titled VLOOKUP, filter out (remove) #N/A.

a. This step removes individuals who are not active.
12. Filter the report as follows:
a. In the column titled Trainings Completed, filter out (remove) Yes.
b. In the column titled Termination Date, leave only the (Blanks) option.

c. In the column titled Training Due Date, filter out (remove) future dates. This will
remove the individuals who are not delinquent.

13. Copy the remaining data to a new worksheet and name the new worksheet, 2-year
Delinquent Report.

3 2-year Delinquent Report 2024 T

14. Delete the following columns:
Termination Date,
Training Start Date,
Training Due Date,
Completed Date,

Training is Due,

Training Attempts,
Training Grade, and
College

e N =

Frequency of Review

This procedure will be reviewed in collaboration with HSCEP OP 52.01, Institutional Compliance
Plan (July of every year), or if the process changes by the designated Compliance personnel.

Review Date: 11/03/2023, 11/22/2023, 12/6/2023, 5/7/2024
Revision Date: 11/03/2023, 11/22/2023, 12/6/2023, 5/7/2024
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